F. Special Features

Search Feature

Where there are a large number of transactions in the All Transactions window,
the Search feature in FECFile can be used to limit the number of transactions

you need to look through. To use this feature:

[& FECfile - [All Transactions]
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Agarwe
Ajamy,
Agamy,
Akel, Gt
Abert,
Aberta
Aicee, [
Alcee, [

Indwiduals/Organzations

Reports
Al Transactions

Summary Page
Receipts

Disbursements

Loans and other Cblgations

Recyde bin
Sort...

Aidrich, Ronaid R.
Alese, Dominick
Alpern, Harian
Aperm, Harian
Andrew, Raiph
Andrew, Raiph
Anglm, Carmela
Appel, Richard W.
Archer, Kimi ),
Arkins, Carole
Amt, John
Amoid, Thomas
Augustine, Joseph

Ayer, Los

Baley, Angela
Baker-Stone, Lori
Balantine, Faye
Barbash, Maurice
Barden, Lesie
Bamard, Charies F.
Barton, Alan
Baum, John C,
Beal, Kenneth
Beal, Fatrica
Beauleu, Sue
Beedenbender, Patrica
Beeman, Linda
Belng, Celne
Beimont, H. Michael
Bebnga, Faul
Benander, Dougas
Benazzi, Robert B.
Benjamn, Earl
Bennett, Austn
Bentham, Kendrick
Bergstedt, Jan-Enc
Berinsten, Henry
Rermstein. Richard
Search the transactions.

Cuisr

IBlieLde S

Date | Amount | Id -
52002 150.001716
Boja002  250.00 027
B5/2002  500.00 611
prr2oo1  s0.00 809
17/2001  250.00 988
psia002  250.00 603
D7/2001  100.00 932
ps/a002  100.00 697
pafa002 25000 346
17/2001  100.00 951
5/2002  100.00i847
1220/2001  1000.001043
11/15/2002  100.00 837
10/17/2001  50.00:307
05/28/2002 50.001164
10/17/2001  750.001356
10/07/2002  1000.00:396
10/30/2002 50.001949
12/05/2001 25001727
10/17/2001 20.00 401
10/05/2001  100.001192
10/05/2001  25.004170
08/02/2002  100.00:223
09/19/2002  100.00i328
10/25/2002  25.00491
10/17/2001 25.00 1269
10/25/2002  75.001637
08/02/2002  50.00225
11/29/2001  100.00 538
12/05/2001  150.00769
10/17/2001  50.00:393
11/29/2001 25.00 650
11/15/2001  50.00541
12/07/2001  50.00:924
11/15/2002  50.001802
09/19/2002 75.00 266
10/25/2002  50.001503
10/05/2001 25.00:227
10/19/2001 25.00 430
10/25/2002  150.00i710
10/05/2001 50.001184
10/25/2002 50.00 489
12/07/2000  50.00/920
10/25/2002 30.001629
10/30/2002  50.00:928
02/27/2002 50.00080
11/29/2001 25000591
10/30/2002  50.00:382

1202702001 1000.00 060 bt

YE:07/01/2001 - 12/31/2001

v" From the all transactions window click on the View Menu and select
Search...or simply press the Control and F keys at the same time. This will
open the Search interface.
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[& FECfile - [Search Results]

Text

|rich ard

Diate Erom

Cancel

Diate Thru

[l Fe Edt Vew window Hep
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11(2)
11(2)
11(2)
11(2)
11(2)
11(2)
11(2)
11(a)
11(2)
11(a)
11(a)
11(2)

11(a)

Ready

Line# | Name

Appe, Richard \
Bemstein, Richz
Braun, Richard
Hoffman, Richal
Hogg, Richard
Ketcham, Richa
Lagnese, Richar
Laurenzo, Rich
Lippe, Richard
Magnussen, C
Mathews, Richa
Q'Kane, Richarc
Park, Richard §
Petrio, Richard
Peere, Richard

Speisman, Richi

Descripton

Date
12/05/2001
12/27/2001
10/30/2002
10/25/2002
09/19/2002
10/05/2001
10/21/2002
10/05/2001
05/15/2002
11/15/2001
12/07/2001
10/25/2002
10/19/2001
10/25/2002
10/05/2001
10/25/2002

10/25/2002

Amount | Id
25.00/727
1000.00 060
500.00024
25.00 584
100001274
500.001162
50.00 419
25.00217
50.00304
100.00 565
100.00 831
100.00 495
50.00 455
100.00 541
100.00 207

|10/19/2001]  25.0046

50.00 787

YE:07/01/2001 - 12/31/2001

v' The results of the search are displayed in the Search Results window.
Note, the search looks for the text you seek in the Name, description,
address, and memo text. As an example: Greg Schultz, above...lives on
Richards Road.

NOTE: Use the resulting transactions as if they were in the
all transactions window.
displayed at a time.

Also, only one search results is
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Sort Feature

In a window, the user can sort the transactions in a useful order by using the
Sort Function a Follows.

[& FECfile - [All Transactions]

. I mdmduakmrganmmrvs E = m - e.@ ."-:, @
Date

Line# | Name  Reports Amount  Id -
6(a) Al Transactions 01/01/2001  B086.89 111
11(z) Abrame 10/25/2002  150.007716
11(a) Ackerm ~Summary Page 10/30/2002  250.00.027
11(a) Ackmal  Receipts 10/25/2002  500.003611
11(a) AgQaWZ  Dibursements 12/07/2001 50.00 809
11(2) ARMY.  |gans and other Oblgations 12/17/2001  250.00 988

11(a) Ajamy, 10/25/2002  250.00603

Recyce bin 12/07/2001  100.00 932
10/25/2002  100.00697
09/24/2002  250.00:346
12/17/2001  100.00 961
11/15/2002  100.00 847
12/20/2001  1000.00 043
11/15/2002  100.00:837
10/17/2001  50.00:307
11(z) Apem, Harian 06/28/2002 50.00:164
22 Amencan Hosptal Association | Transfer to Affiated SSF 01/26/2001  5000.00:124
22 American Hospltal Assocition | Transfer to Affflated SSF 06/13/2001  5000.00:131
22 American Hospital Association ¢ Transfer to Afflated SSF 10/12/2001 10000.00 410
22 American Hospital Association | Transfer to Affiated SSF 10/19/2001 _20000.00 411
22 American Hospital Association | Transfer to Afflated SSF__ 11/06/2001 _5000.00 536/
22 American Hospital Association ¢ Transfer to Afflated SSF 11/12/2001  5000.00 537
22 American Hospital Association | Transfer to Afflated SSF 11/16/2001  5000.00 706
22 American Hosplal Association | Transfer to Afflated SSF 12/10/2001 15000.00 707
22 American Hospital Assocktion | Transfer to Afflated SSF 12/20/2001  7000.00 712
22 American Hospital Association | Transfer to Afflated SSF 02/19/2002 10000.00-:108
22 American Hosplal Association § Transfer to Afflated SSF 05/20/2002 10000.00 215
22 American Hosptal Assocition | Transfer to Afflated SSF 0B/12/2002 10000.00:350
22 American Hospital Association | Transfer to Afflated SSF 09/20/2002 10000.00 351
22 American Hospial Association F Transfer to Afflated SSF 10/01/2002 10000.00 404
22 American Hosptal Assocition | Transfer to Afflated S 10/28/2002  5000.00 853
22 American Hospital Association | Transfer to Afflated SSF 11/08/2002  5000.00:860
22 American Hospital Association | Transfer to Affiated SSF 11/15/2002  5000.00 861
22 American Hospital Assocition | Transfer to Affiated SSF 10/21/2002 10000.00 044
22 American Hospital Association | Transfer to Afflated SSF 12/09/2002  9500.00.063

11(a) Andrew, Ralph 10/17/2001  750.00 356
11(a)  Andrew, Raiph 10/07/2002  1000.00 396
11(a) Angim, Carmela 10/30/2002  50.00:949
11(s) Appel, Richard W. 12/05/2001  25.00 727
11(2)  Archer, Kimi ) 10/17/2001  20.00401
11(a) Arkins, Carcle 10/05/2001  100.00:192
11(z) Amdt, John 10/05/2001 25.00170
11(2)  Amoid, Thomas 08/02/2002  100.00:223
11(a) Augustne, Joseph 09/19/2002  100.007328
11(a) Ayer, Los 10/25/2002 25.00 451
11(a) Baiey, Angela 10/17/2001 25.00 269
11(a) Baker-Stone, Lori 10/25/2002  75.00637
11(z) Balantne, Faye 0B/02/2002  50.00:225
1103} Rarhash. Maurice 11292001 100.00 508 L
Sort the tems in the active view YE:07/01/2001 - 12/31/2001

v" From any transactions window click on the View Menu and select Sort.
...or simply press the Control and R keys at the same time. This will open
the Sort interface.

NOTE: Each transaction window can have its sort
preferences set independently. Set up your sour preferences
for each window.
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|Am0unt
<Mone>
Line#
MName
Date

|<NDne)

|<NDne)

1]

|<NDne)

Aggregate
Id

OFK. | Cancel ‘

Parent

v' There are four levels of sorting available. The top box sorts first, then the
second box and so forth

v" The options for sorting are shown above, and are from low to high.

Merge Feature

When there are multiple entries for a single unique contributor, you can use the
Merge Function to merge multiple entries into one entry for a unique
contributor. This helps improve tracking and reporting of aggregate totals for
contributors.

[& FECfile - [Receipts]

By edt vew window Hep

S-S EN] XYY T
= open. cuto = ) e
Lln Close Ctri+w Amount | Aggreg... L. P. -
11 001 500 5.00 66
1 save As.. 001 5.00 5.00 01
11 001 1500  15.0025
11(  Import.. 001 2000  20.0046
11(  Import Names... 001 2000  20.00 68
1 export ames 001 2000  20.0023
11(, 001 2000 20,0045
11¢ 001 2000 20.0001
11 Badp.. 001 2000  20.0019
11(  Check Umits 001 20.00 20.00 05
11 001 2000 20.0017
1y VaMdate Crriy 001 2000  20.0065
11(  Print Report Ctrl+shit+p oo 25.00 25.0003
11(  Upboad... 001 25.00  25.0052
11{  update Commitee List 001 25.00 25.00 64
11 001 25.00 25.00 70
11 Print... Ctrisp. 001 25.00  25.0072
13(  print Setup 001 2500  25.0074
10 print preview 001 2500  25.0076
11 001 25.00 25.00 15
13( 1 pof1 versions .oCk 001 2500  25.0017
nf 2TETeonod oo o 0020
p( numod 001 25.00  25.0027
11 4AUTHLDCH 001 2500  25.0049
11( Extt 001 25.00 25.00 69
11 001 2500 250001
11(aju Roche, Mary Ann 10/17/2001 2500  25.0085
11{a)u Dimon, Leonard 10/17/2001 25.00 25.0097
11(a)u Eberly, James 10/19/2001 2500  25.0045
11(a)u Messheo, Hedy 10/19/2001 2500  25.0049
11(a)u Sab, Jack 10/19/2001 25.00 25.00 59
11(a)u Schulz, Gregory M. 10/19/2001 25.00 25.00 61
11(aju McLeod, Christine 10/19/2001 2500  25.0077
11(z)u Murray, Kevin 10/19/2000 2500  25.0086
11(a)u Beling, Celne 10/19/2001 25.00 25.00 50
11(aju Santas, Lee 1019/2001 2500  25.0099
11(z)u McNamara, Sharon A. 11/15/2001 2500 250055
11(a)u Tanney, Karen 11/15/2000 2500 250061
11(aju Hende, Shary! 11/15/2000 2500  25.0067
11(z)u Senn, Lamy 11/15/2001 2500 250069
11(z)u’ Polard, Amy 11/29/2001 2500 250032
1i(aju Mier, Victoria 11/29/2000 2500 25.0034
11(a)u Ward, Marguerte 11/29/2001 2500 250036
11(aJu McCabe, Ria 1/29/2001 2500 250040
11(a)u Shafer, David 11/29/2001 25.00 25.00 42
11(aju Stoddard, Ruth 1/29/2001 2500 250044
11(a)u Tryon, Clara 11/29/2001 25.00 25.00 46
102N Rarton. Aln 11297001 9E00 250050 L
Merges the posstie dupicates in names user-inter: YE:07/01/2001 - 12/31/2001
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v" From any transactions window click on the File Menu and select Merge
Names. ...This will open the Merge interface.

Merging possible duplicate name en‘kies

First occurence Fossible duplicate
Last/ Business Name ~ |ENGELFOR CONG j EL FOR CONGRESS]
First Name ‘ J |
MName Prefix ‘ J |
MNarme Suffix ‘ J |
Addiess line1 | |462 CALFORNIARD << | [482 CALIFORNIA RD
Address, line 2 ‘ J |
Oty |BRONKVILLE << | [BRONKVILLE
State | | =l J | New vk =l
Zip | [10708 << [ro708
Employer ‘ J |
Occupation ‘ J |
Save s far & Quit Mertge ﬂ Don't merge
Cancel All Merge ‘ Resetto As it Was |

v' The system shows the first occurrence of a possible duplicate name in the
left column. In the right column it shows the next occurrence of a possible
duplicate.

v If the right column information is correct you can update the left column by
clicking on the arrowed buttons. The << buttons will update individual data
items. The <<< button replaces all left column data with all the right column
field values.

v" When the left column data is correct, selecting the Merge Button uses the
left column information for the Merge of both.

v If the records are not duplicate, select the Don’t Merge button

v" When you select the Merge button, the following message is shown.
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.,E You are about to merge the two occurences of ENGEL FOR CONGRESS - 462 CALIFORNIA RD.... Once you
L] complete the operation and save the file, the change cannot be undone. Are you sure? If you cancel, you wil be
taken to the names window. If you select No, merge wil ignore this record and continue to search for other

duplicates!

v" When you select the Merge Button the system provides a notice to confirm
the action. Select Yes, and you are returned to Merge interface, and the
next comparison is shown.

v If you become confused for a given merge transaction, press the reset
button to return to the start of that transaction. If you desire to stop the
whole merge process select the Cancel All Merge button.

v" When all merges have been processed, the following is shown. It shows
the number of merged names and provides the option to save the changes
done.

!E 3 records were merged. Do you want to save the changes now?

oK | Cancel ‘

NOTE: If you select Cancel...All the merge selections are
deselected, and you will have to start over again.

v If, in the middle of the work (you are not completed with the merge process)
but want to save the work so far, press the Save so far and Quit button.
You will keep the merged items. The function can be run again at a later
time to address the additional duplicate names.
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